
About AVGuard/9x
In this window, you will find information about AVGuard/9x and its control program.

Version information
In the first line, you will see the version and date of generation of the AVGuard/9x 
control program. The next line contains the version number of the AntiVir search engine 
used. The third line shows the version, date of generation and FUP type of the virus 
definition file currently in use.

Hotline / other product information
If you require technical support, product details or any other information, you can 
contact us at one of the addresses listed here.



Action
This dialog window enables you to configure the actions to be performed by AVGuard in case
a virus is detected.

Action if file is not repaired
If AVGuard finds a virus, what happens next will depend initially on the setting under 'Display
Warning Message'. If this switch is activated, AVGuard will open a dialog box in which the 
user can personally select the action to be taken. If the virus was able to be removed and 
the repair mode is activated, the user can choose, among other options, to repair the file. If 
the repair attempt fails, the action selected in this group will be performed. If the user 
selects a different option in the displayed dialog box (e.g. deletion) this will be carried out 
whatever the default setting in this group. If the warning messages are deactivated, 
AVGuard will respond fully automatically to an infection. If the repair mode is activated and 
the virus can be removed, AVGuard will attempt to do so. If the repair attempt fails, the 
option selected in this group will be carried out. If the automatic repair function is not 
activated, the default setting of this group will be applied automatically.

Deleted Infected File
The infected file is deleted but can be restored with the aid of a suitable program.

Move Infected File
The infected file is moved to the quarantine directory, which means that it can no longer
be accessed directly. Please note that only the administrator should have access to this 
directory.

Rename Infected File
The infected file is renamed according to the pattern *.001, *.002 etc. This means that it
can no longer be executed directly by the shell.

Ignore File
The infection is merely entered in the report file if activated.

Messages

Display Warning Message
AVGuard will only notify the user of an infection via a dialog box if this option is 
activated. In this dialog box, the user can decide for himself what to do with the infected
file. Unfortunately, the platform for Windows 9x is still DOS, which means that a 
Windows dialog box cannot be displayed at this stage, but only a selection menu in text 
mode.

Quarantine directory
If a file is to be moved, AVGuard will transfer it to the directory indicated in this box.



Activate AVGuard 
If you select this option, the virus scan of AVGuard/9x will be activated. This means that the 
resident Guard will scan all files for viruses from now on according to the chosen settings. 
The default setting    is 'activated'. If AVGuard is already activated, this menu option will be 
greyed out, which means that you cannot select it. Please note that you may need a 
password for this option if entered under Configuration/Password.



Clear Statistics
This option enables you to delete the internal statistics of AVGuard/9x. All numeric values 
are reset to zero and all text boxes to a blank line. You can also reset the numeric values to 

zero via the  button.



Configuration
This menu option opens a dialog box containing all the available configuration options. You 

can also obtain this window via the  button.
In it, you can select one of the following index cards:

Scan Contains all settings used for the device driver or scan.
Action Defines the actions to be performed by AVGuard in case a virus is detected.
Report Defines the settings for the report file.
Password Enables you to enter a password to protect the configuration and    

activation/deactivation function.



Deactivate AVGuard 
If you select this option, the virus scan of AVGuard/9x will be completely deactivated. This 
means that the resident Guard is still loaded, but will no longer scan for viruses. This menu 
option should be treated with caution, as once the Guard has been deactivated no more 
viruses will be reported. The default setting is 'activated'. If AVGuard is already deactivated, 
this menu option will be greyed out, which means that you cannot select it. Please note that 
you may need a password for this option if entered under Configuration/Password.



Demo Version
Demo Version

If you do not have a valid licence file, AVGuard/9x will run in the restricted demo mode. 
In this case, only files on the local drive C: are scanned and repaired.

In order to install a registered version, all you need is a valid licence file, which has to 
be copied to the installation directory of AntiVir/9x. Once you have rebooted the system,
AVGuard/9x will function as a registered product.



Display Warning Messages
AVGuard/9x can be configured so that it either responds automatically to infected files or 
asks the user what action to take.

If the option 'Display Warning Messages' is activated, a dialog box is opened for each file 
found to be infected. The user can now choose whether - if possible - he wishes the file to be
repaired or whether another action should be performed. If this option is deactivated, 
AVGuard/9x performs the action selected under 'Action If File Not Repaired'.



Exit and Close
Select this function if you wish to exit the control program of the AVGuard/9x and close it 
completely. Thereafter, the program can only be started via the corresponding icon in the 
program folder of AVGuard/9x.



Exit and Minimise

or  button

Select this entry if you wish to exit the AVGuard/9x control program without closing it 
completely. In this case, it will be reduced in size (minimised) and you will then see the 
program icon in the bottom right-hand corner of the taskbar display area. To enlarge the 
control program again, simply double-click on the reduced icon. In the minimised state, the 
program does not take up any computer time. After minimising the icon, you can call up the 
Context menu by clicking the right mouse key on the reduced icon.



File Action
In this box, you will see the currently selected action to be performed by AVGuard/9x in case 
of a virus infection. Please note that this action will only be performed if the option 'Display 
Warning Messages' is deactivated or if the virus is unable to be repaired.

Repair File
AVGuard/9x attempts to repair an infected file. If the repair attempt fails, the action 
selected under 'Action if File not Repaired' is performed.

Delete File
The infected file is deleted and overwritten. In this case, it can no longer be restored, as 
the virus signature might otherwise be detected again on your volume.

Move File
The infected file is moved to the directory specified under 'Quarantine Directory'. If a file
of the same name already exists, the file is moved and renamed according to the 
pattern *.001, *.002, etc. The files in this directory can be repaired subsequently or - if 
necessary - sent to us for further investigation.

Rename File
The infected file is renamed *.VIR. This is designed to prevent direct shell access to 
these files (e.g. double click). You can repair these files later on and rename them back 
again.

Report Only
AVGuard/9x will only inform you of the infection, without taking any further action.



File Extensions
This list of filename extensions is used by AVGuard/9x if the option 'Program Files Only' is 
activated.
You can edit this list as follows:
{button OK,}

Closes the window and accepts the current list.
{button Abbruch,}

Cancels the editing process and rejects all changes.
{button Einfuegen,JI(`',`HELP_EDIT_EXTENSION')}

Opens a further window in which to enter the new file extension you wish to include.
{button Loeschen,}

Deletes the highlighted entry from the list.
{button Standard,}

This button sets the default settings supplied with AVGuard/9x. Please note that the list 
of default extensions may change as new viruses are added. (See READ.ME). The 
current default extensions are: 
*.386 *.APP *.BIN *.CMD *.COM *.DLL *.DOC *.DOT *.DRV
*.EXE *.HTM *.MDB *.OBJ *.OVL *.OVR *.OV1 *.OV2 *.PGM *.PPT
*.PRG *.SCR *.SYS *.VBS *.VXD *.WIZ *.WWK *.XLS *.XLT

{button Hilfe,}
Displays this help text.



Help Index

The following pages are available:

About AVGuard
Action
Activate AVGuard
Clear Statistics
Configuration
Deactivate AVGuard
Demo Version
Display Warning Messages
Exit and Close
Exit and Minimise
File Actions
File Extensions
Main Window
New File Extension
News
Password
Report
Scan
Search
Status
The File Menu
The Help Menu
The Options Menu
Troubleshooting
Virus Infection



Index Card 'Password'
This index card allows you to protect the settings of AVGuard/9x against unauthorised 
access.

Password

Please Enter Password
This is for entering the password to be requested on opening the Options Dialog Box. It 
is not visible in plain text, but represented by asterisks. You can enter a maximum of 32 
characters. Attention: this function distinguishes between upper and lower case letters. 
Once you have specified the password, AVGuard/9x will always ask for it before opening 
the Options Dialog Box or performing the options 'Activate AVGuard' and 'Deactivate 
AVGuard', and will deny the user access if it is not correctly entered.

Confirm Password for Security Reasons
Enter the above specified password again here to confirm it. This is intended to prevent 
you from locking yourself out in case you make a typing error the first time. The 
password is not visible in plain text, but represented by asterisks. You can enter a 
maximum of 32 characters. 



Main Window
This takes you to the main window of AntiVir Guard for Windows 9x:

The menu bar options

File
Options
Help

Display group 'Configuration'

Service Status: Displays the current status of the AVGuard/9x service.
File Action: Displays the action to be performed if the user warnings are 

deactivated.
Scan Files: Tells you what is to be scanned: all files or only those with special file 

extensions (program files).
Report: Indicates whether the user is to be notified first or whether the 

selected action is to be performed automatically.
Last File: The name of the last file scanned by AVGuard/9x.

Display group 'Statistics'

In these output boxes, you will see the current statistics of AVGuard/9x. Please note that 
these figures are only updated twice a second for performance reasons. You can reset these 
statistics to zero with the option 'Clear Statistics'.



Number of Files: The number of files already scanned.
Last Virus: The name of the last detected virus.
Number of Viruses: The number of detected viruses.
Repaired: The number of successfully repaired files.
Moved: The number of files successfully moved to the quarantine directory.
Deleted: The number of successfully deleted files.
Renamed: The number of successfully renamed files.



New File Extension
In this window, you can enter a new file extension to be added to the file extension list. This 
may contain a maximum of 6 characters.

{button OK,}
Inserts the new file extension in the file extension list.

{button Abbruch,}
Rejects the current extension without inserting it in the list.

{button Hilfe,}
Displays this help text.



News
The latest features and news on AVGuard/9x

Password protection for options
AVGuard/9x now offers password protection for the various options. This enables 
administrators to protect the AVGuard settings against unauthorised changes, and also 
allows a flexible choice of file extensions.

Did you know that ...
... AntiVir MailGate is now available for Linux, FreeBSD and OpenBSD? It provides 

powerful virus scanning and content filtering features.
... the new AntiVir search engine can detects nearly 60.000 viruses and virus strains?
... AntiVir is also available for Windows NT servers?
... computers using AntiVir have been protected against VBS.LoveLetter (ILOVEYOU) 

already 2 hours after detection?
... AntiVir is now available for Linux, FreeBSD and OpenBSD and it is free of charge for 

private, non-commercial use? All you need to do is to register. More information can 
be found in the Internet at www.hbedv.com.... AntiVir is also available for 
Windows NT servers?

... there is now also a graphic user interface for AntiVir for Linux called TkAntiVir? This 
product, created by Stefan Geiges, is subject to the GNU General Public Licence (GPL)
and can be downloaded free of charge from the author’s homepage 
(http://www.geiges.de/tkantivir/index_en.htm).

... H+BEDV has developed the world’s first resident virus guard? AVGuard/X has been 
specially designed for servers under the free operating system Linux (e.g. with Mars, 
Samba).

... the Secure AntiVirus Application Programming Interface (SAVAPI) offers a 
programming interface for our antivirus software which enables you to create your 
own individual antivirus program? AntiVir SAVAPI is particularly ideal for email 
gateways, firewalls and specific client-server solutions.

Further information and news can be found in the internet under http://www.hbedv.com



Report
AVGuard/9x is equipped with a logging facility which can provide the user with precise 
details of the nature of an infection.

Name and path of report file

Activate Report Function
When this option is activated (and only then), AVGuard generates a report file detailing 
the main actions such as virus messages and errors. 

Name of Report File
This entry contains the path and filename of the report file to be generated. All entries 
are appended to the end of this file. You can select a file/folder via the button with the 
folder symbol. If you specify a file with a long name, it will be automatically shortened. 
AVGuard has to use short file names, as the support for long file names is not yet 
available via Windows when AVGuard is started up. 

Size of report file
AVGuard/9x can limit the report file to a fixed size:

Limit Report File To
Activate this option if you wish to restrict the maximum size of the report file.

Size in Kilobytes
Here you can enter the maximum size of the report file in kilobytes. The default setting 
is 25 Kb. You can increase or decrease this value using the small arrow keys.



Scan
AVGuard/9x offers the possibility of setting a file extension filter allowing you to select the 
files you wish to scan:

All Files
All accessed files are scanned for viruses, i.e. the filter is deactivated.

Program Files Only
Only files with an extension specified in the List are scanned for viruses. This is the 
default setting. You can change this list yourself. Please note that the default list may 
vary from one version to the next.



Search
Scan
AVGuard/9x can use a filter in order to limit the number of files to be scanned. Since the 
filename extension in PCs normally also indicates the type of file in question, AVGuard/9x is 
equipped with a filter which limits the data to be scanned to files with a specified extension.

All Files
If this option is selected, all files are automatically scanned for viruses.

Use file extension list
In this case, only files with a file extension included in the list are scanned for viruses. 

{button File extensions,JI(`',`HELP_FILE_EXTENSIONS')}
Displays the list of file extensions for the user to edit.

Drives
AVGuard is able to differenciate between local drives and network drives when monitoring 
the computer.

Local drives
If activated, AVGuard will monitor local drives such as hard disks, floppy disks, CR-Rom 
drives, ZIP-drives, etc. (Default)

Network drives
With this option activated, AVGuard monitors mapped network drives and UNC drives. 
This option is deactivated by default.

Infected files

Activate Repair
This function is used to activate the repair mode of AVGuard/9x. Unless this option is 
activated, AVGuard/9x cannot repair infected files and does not offer to do so in the 
dialog box. In other words, this option must be activated in order to be able to select 
the repair option on receipt of a warning message.

Shutting down the system

Warn if Floppy Disk is in Drive A:
If this option is activated, AVGuard/9x checks before shutting down the system whether 
there is still a floppy disk in drive A:. If so, you will receive a corresponding warning 
message. This option is recommended, as many viruses are still spread via the boot 
records of floppy disks. If you forget to remove an infected floppy disk from drive A: on 
shutting down the computer and the starting option in the BIOS of the computer is set 
to A: / C:, you run the risk of infecting it with a boot record virus next time you boot the 



system. In fact, if you see the message "Non system disk or disk error", a virus may 
already have infected your system.



Status
This field displays the current status of AVGuard/9x.

Active
This means that the virus scan of the VxD is active and in the process of being carried 
out according to the settings.

Inactive
This means that the virus scan of AVGuard/9x has been deactivated. In other words, no 
virus scan is being carried out and all files can pass through the system unchecked.
Attention: When the Guard is deactivated, you have no automatic protection 
against viruses!



The File Menu
This submenu contains four entries:

Exit and Minimise or  button
Select this entry if you wish to exit the AVGuard/9x control program without closing it 
completely. 

Exit and Close
Select this entry if you wish to exit the control program and close it completely.

Activate AVGuard
Select this function to activate the virus scan in AVGuard/9x.

Deactivate AVGuard
Select this function to deactivate the virus scan in AVGuard/9x.



The Help Menu
In this menu, you will find information on AVGuard/9x and how to operate it.

Help (F1) or  button
Opens the context-sensitive help system (these pages). 

How to use Help
This tells you how to use the context-sensitive help system.

Help Index
Displays a page containing cross-references to all available help pages.

About AVGuard/9x
This menu option opens a window containing further information on AVGuard/9x 
together with our addresses. 



The Options Menu
This menu contains 2 entries:

Configuration    or  button
Select this menu option to configure AVGuard/9x.

Clear Statistics    or  button
Select this menu to delete the statistical data.



Troubleshooting
Should AVGuard fail to work, or in case of problems with AVGuard/9x or a virus infection 
which you are unable to remove yourself, you should note or check the following points:

- Is the VxD active? The icon (umbrella) in the bottom right-hand corner of the system tray
should be open! If necessary, activate the VxD by selecting the entry 'Activate 
AVGuard' in the 'File' menu of the control program. Failing this, you may have to 
uninstall AntiVir/9x completely via 'Start / Settings / System Control / Software', then 
restart the computer and install AntiVir/9x afresh.

- Check the setting in the group Search / Scan. If 'Program Files Only' is activated here, 
you should check the File Extension List and set it to the default values if necessary.

- In order to carry out repairs, the repair mode must be activated under Configuration / 
Search !!

- Has AVGuard/9x actually scanned the file? Check the statistics window to see whether 
the relevant file is displayed.

Further information can be found in the README.WRI file in the root directory of your CD-
ROM, in the READ.ME file in the program directory of AVGuard/9x or in the internet under 
www.hbedv.com

In case of problems, you are also welcome to contact our Hotline for help. You can reach us 
at one of the addresses below. In order to ensure quick and effective assistance, you should 
have the following information at your fingertips:

- Your serial number (from the file LIC_INFO.TXT on your licence disk).
- The version numbers of the VDF file, engine and program.
- The version of your operating system and any installed service packs.
- Installed software packages, e.g. other makes of antivirus software.
- Exact (!) messages of the program or log file.

Our addresses:

H+BEDV Datentechnik GmbH Internet: www.hbedv.com
Techn. Support Email: support@hbedv.com
Lindauer Strasse 21 Tel: +49    (0) 7542 - 93040
D-88069 Tettnang Fax: +49    (0) 7542 - 52510
Germany



Virus Infections

If AVGuard/9x has detected a virus ...

1. Don’t panic - keep calm!
Provided it is properly configured, AVGuard/9x will normally have completed all the 
important tasks for you automatically. If you try to start or load an infected file 
accidentally, it will be automatically repaired or moved where possible and access to it 
will be denied. Once the file has been repaired, you can carry on working as usual. If it 
cannot be repaired, it will be moved (depending on the default setting) to a quarantine 
directory and you will receive a corresponding warning message.

2. Proceed systematically - don’t do anything hasty!
It is important that you now check your workstation computer and any possible infected 
floppy disks or data media for infection. This is best done with AntiVir/9x, which was 
installed together with this package. Now repair the infected files or boot records. If you 
encounter any problems, ask your dealer or contact us for assistance. You may need to 
activate the automatic repair function of AVGuard/9x. If AntiVir is unable to remove the 
virus, please send us the infected file for inspection. We will then offer you a solution 
immediately. Try to find out where the virus came from. Your antivirus strategy may 
need revising in order to prevent any further infections.

3. Notify everyone with whom you have exchanged data or data media found to be 
infected!

It may be an unpleasant duty, but this information is important! If the virus came from 
outside, it is essential that you warn the person who sent the infected file. You must also
notify your system administrator or virus protection officer of the infection. If the 
infection occurs at your place of work, notify all staff and all business partners with 
whom you have exchanged data since the infection.

4. Unknown viruses and suspicious files
Please send new or unknown viruses or suspicious files in an encrypted archive (ZIP) as 
a email attachment to virus@hbedv.com. Please don't forget the password and a short 
file or problem description.




